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This month’s AUGIWorld is about customization, which means we’ve all 
got programming on our minds... but honestly, I really can’t blame that on 
the magazine theme. I’ve been thinking a lot about how we interact with 
software—specifically, how we assign “responsibility” to the programs we use.

It’s very easy to fall into the habit of using passive language to describe software actions, or of assigning 
the action to the software itself. “I would have been here on time, but my maps app sent me the wrong 
way.” “My alarm didn’t go off this morning.” “That Revit schedule isn’t showing the right information.” 

But is that really the best—or the safest—way to think about it? Any program is only as good as its 
input and its algorithm. A flaw or failure in either component can lead to suboptimal output. Did your 
maps app really send you “the wrong way” or did you miss a turn? When your alarm “doesn’t go off,” did 
its internal clock break or did you forget to set it? If your Revit schedule doesn’t look right, is it really 
broken behind the scenes or did you choose the wrong fields—or model the wrong elements? (Is it a 
coincidence that these examples also have to do with assigning blame?)

Most of us who aren’t programmers tend to view software as a “black box.” We don’t have the training 
or the expertise to fully understand the source code, so the output is all we have to go by. That’s why it’s 
our responsibility to thoroughly test any program or piece of code we intend to use in our workflow—
whether it’s a complicated Dynamo script you wrote yourself or a LISP snippet you downloaded from 
the AUGI forums.

How do we do this? It’s pretty easy: feed the program input with known solutions and see if you agree 
with its conclusions. Start small and work your way up to more complicated problems. If the results 
coming from the program match up with your own solutions—based either on your own calculations 
or personal experience—you can start to trust the answers to problems with previously unknown 
solutions. (Remember the value of estimations, too. If you’re expecting a number output, you should 
know beforehand whether that number is about 10, about 100, or about 1,000. It’s a quick gauge of 
reliability.)

For more complex software, the output by itself isn’t enough to completely earn our trust. We want to 
know how it works, preferably in as much plain language as possible.

This leads me to my second point, and what I’m beginning to think of as the three most important 
things in programming: Documentation, documentation, and documentation. All right, maybe that’s 
a slight exaggeration. But I’ve encountered a few professionally released programs lately that have, at 
best, bare-bones help files. Getting started in these programs has been a challenge, to say the least. 
Without documentation, it’s practically trial-and-error to understand what will work as input and what 
we should expect as output. Yes, good interface design can alleviate some of that work. But it makes it 
that much harder to trust the program’s results.

If you’re writing your own code, please, for the sake of those of us who will use your program in the 
future (including you, six months from now), include notes everywhere. Describe everything that’s 
going on, and what the result of each step should be. It may seem like overkill, but your colleagues—or 
customers—will thank you for it. It goes back to our habit of assigning responsibility to software. Since 
it’s unlikely that we’ll stop saying “the program says…” we need to be that much more aware of how the 
software “thinks.”

In the end, just remember that every bit of software we use today was, at some point, written by a 
human being. (This statement may not be true once robots have taken over... but for now, I think it 
stands.) The output is based on human interpretation of data. Fortunately, software won’t get offended 
when you question its results. Keep checking, keep verifying, and you’ll be able to celebrate the things 
that technology enables you to accomplish instead of wondering what went wrong!

Kate Morrical
AUGI President
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Component 
Road 
Customization

R
oads are one of the most powerful tools 
in InfraWorks®. Component roads, to be 
exact. Why? Because component roads 
allow you to design based on AASHTO 

and DMRB design standards, manipulate 
vertical curves using a live profile editor, and generate cut/fill 
calculations based on their associated grading styles. But the 

real power of component roads lies in their ability to be highly 
customized to create just about any roadway style, intersection, or  
configuration imaginable.

From Autodesk InfraWorks Help: “Component roads are assemblies 
of different parts, such as lanes, curbs, gutters, medians, shoulders, and 
sidewalks. You can add, split, delete, or modify EVERY component 

➲
Figure 1: Component placement along a road
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InfraWorks

and assembly in your roadway project, and save custom road 
assembly configurations to your Library so you can use them again.”  
See Figure 2.

Simply put, you can easily 
piece together a roadway 
using any number of 
components, placing them 
at any location along a 
road, and for any length, 
and giving them the ability 
to transition in and out 
smoothly (for example, to 
create a bus drop-off area) to 
give your road the right look 
and feel for your project.

You can also add 
decorations along the road 
such as guard rails, barriers, 
light poles, etc. And when 
your roadway is complete, 
you can then save that 
assembly for later use in 
your project. Or, as you’ll 
see toward the end of this 
article, how you can save 
the assembly and use it in 
any project.

When working with 
component roads, it’s 
important to understand 
that the individual 
components you choose 
perform specific functions 
and may react unexpectedly 
when used in a situation 
they aren’t designed for. 
Figure 3 shows an example 
of a component road that 
was built using three lane 
components; one lane 
component to represent 
the single yellow stripe and 
two-lane components for 
the actual drive lanes on 
either side of the yellow 
stripe. When the road is by 
itself it looks fine, but when 
it crosses another road, 
things go awry. 

Because there are three 
lanes in use, InfraWorks 
assumes the yellow stripe is 
actually a drive lane (which 
technically it is, in this 
example) and therefore uses 

that center lane’s material to fill the intersection. Also notice the 
turn arrows on the botton and left side extend over the yellow line. 
Again, this is because a lane component was used.

Figure 2: Road Assembly > Add To Library

Figure 3: Incorrect use of components

7
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The proper way to create this particular component 
road style is to use a median component for the 
yellow stripe and lane components on either side. 
This time the turn arrows clean up better and do 
not extend past the yellow line because a median 
component was used (Figure 4).

I mentioned earlier that you can save the roadway 
assembly and use it in any project, and here’s 
how. When you save a custom component road 
assembly, its definition and preview image are 
saved to the project directory in a folder labled 
“Custom.” In that folder are two files associated 
with your custom roadway style: a .PNG (the 
thumbnail preview of the road) and a .ACITEM 
file (this is the actual roadway definition and tells 
InfraWorks which components to use). To find 
these files, browse to the following location: 

C:\Users\<User Name>\
Documents\Autodesk InfraWorks 
Models\Autodesk 360\<model 
number>\<model name>.files\
unver\Content\Styles\
Component\Custom

Then copy them to C:\ProgramData\Autodesk\
InfraWorks\LocalLibrary\Styles\Component\
Assembly and every project (new and existing) 
will be able to use your custom roadway style.

If you’ve never used component roads before, the 
examples in Figures 5 and 6 will hopefully inspire 
you to give them a shot.

Matt Wunch is the BIM Manager 
for ARCAT.com in Fairfield, CT. 
He is an Autodesk Expert Elite mem-
ber, Revit Certified Professional in 
Structure, Architecture, MEP – Me-
chanical and MEP – Electrical, a 
member of the planning committee 
of the Construction Institute’s BIM 
Council, and owner & FAA licensed 
sUAS pilot at SkyViz.io. He can be 
reached for comments or questions at 
matt.wunch@gmail.com or on Twitter  
@MattWunch.
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Figure 4: Correct use of components

Figure 5: Image credit to Matt Wunch

Figure 6: Image credit to Daniel Iliyn, PE, David Evans and Associates, Inc.
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AUGI 
Members 
Reach Higher 
with Expanded 
Benefits
AUGI is introducing three new Membership levels 
that will bring you more benefits than ever before. 
Each level will bring you more content and expertise 
to share with fellow members, plus provide an 
expanded, more interactive website, publication 
access, and much more! 

MEMBER

MEMBER

MEMBER

MEMBER

MEMBER

MEMBER

MEMBER

MEMBER

MEMBER

Basic members have  
access to:
•	Forums
•	HotNews (last 12 months)
•	AUGIWorld (last 12 months)

DUES: Free

Premier members have  
access to:
•	Forums
•	HotNews (last 24 months)
•	AUGIWorld (last 24 months)

DUES: $25

Professional members have  
access to:
•	Forums
•	HotNews (full access)
•	AUGIWorld  
 (full access and in print)
•	ADN	2013	Standard 
 Membership Offer

DUES: $100

Are you ready to upgrade yourself and your membership? 
Access additional benefits and upgrade at www.augi.com
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Developing 
a 

Thick Skin

by: Mark KikerCAD Manager

G
etting frustrated by technology happens 
all the time. Everyone has troubles, 
but not every trouble is related to the 
technology we use. But tech sometimes 

gets blamed for problems and delays. It is so easy to 
blame technology that everyone does it. If you are 

late for a meeting, “My calendar did not remind me.” If you are 
uninformed on the progress of a project, “I did not get the email.” 
If you fail to submit on time, “My system crashed and lost the file.” 
While all of these may be legit, many times I hear people blame 
technology for their woes.  The system is not working. The files 
are corrupt. The menus are not created right. The standards are 
getting in our way. The thing is just not working. I can’t log in. My 
network drive is not mapped. I cannot print. On and on…

As a tech manager when you hear these things, you tend to take 
it as an affront. The underlying sentiment behind many of these 

statements seems to say that “YOU” are not doing your job right, 
or maybe not doing it at all. Or at least you feel like it is about you. 
You feel the weight of the comments and you are frustrated by 
them. But you are doing your job, usually with limited time and 
resources to make great impacts. How can they blame you, or blame 
the machines, or the configs, or the setup, or the customization? 
The comments and critique goes on forever.

You feel bad. You feel frustrated. You feel angry. You feel defeated. 
You want to do the best you can and be appreciated. You are doing 
so much for the firm. They never see what you bring to the table. 
Your mind is racing down the road of anger and bitterness (if this 
has been happening for a while). 

You need to have thicker skin. Having thick skin means you are 
not easily insulted, hurt, or upset. It means that you don’t easily 
anger. You are not easily offended by the comments of others.

➲
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JUST PUSh PAUSE
As your inner temperature rises at these comments, you need to 
push pause. Slow it down. Take it in stride. This is not easy for 
some. You may need to verbally ask others to slow down. Don’t let 
the comments just keep rolling on or just keep quiet until they are 
done. You may need to step away from the situation. If your blood 
is starting to boil, then exit the scene. Just tell them you will be 
right back. Tell them you need to go check on something related 
to the issue. Just get out of the area any way you can. Better to bail 
out than to boil over.

ThInk IT ThRoUGh
First – don’t take things personally. Most likely no one is out 
to get you. It might feel like it, but it probably is not true. Their 
comments are generated by frustration with things going wrong. 
They just want things to work. They have pressures and deadlines 
that cannot slip. They need things to go as planned and when they 
don’t, they look for something (or someone) to shift that pressure. 
As they shift some of the pressure, look at it with the perspective 
that you are assisting to relieve that pressure and avoid piling on 
more. Say something like, “Things may not be going as we planned, 
but I think we can get past this if we look at it together.” Purposely 
take a team attitude and use “we” and “together” in your response. 

If the person really is attacking you personally, like hinting at or 
saying “You do not know how to do your job,” then you should still 
try to manage your attitude. Don’t fight back—that escalates the 
problems. Saying something akin to “It may not be working well 
right now, but others have not seen this trouble. Things successfully 
worked in the past, there must be something new going on.”

Second – see it through their eyes. You may not know the whole 
story. There may be unseen pressures and compounded failures 
that are making the current situation even more stressful. They 
may be having a bad day in the office or have come to work to 
escape the pressures at home. They may be exhausted, fearful, 
overworked, stretched to the limit, or just need to get past this 
issue so they can move on to bigger ones. Think about others first. 
They actually need help. You should be there to help. 

Third – move past it, at least in your head. Don’t stew on it. 
Having thick skin means things can bounce off of you. Don’t let 
it fester. Don’t go into the “fix it” mode with snarling teeth. You 
don’t want to grumble during the repair phase, either. Even after 
you weather the storm of troubles, don’t keeping thinking about it 
or making snide comments about the person. Change the subject 
in your head. Move on to another topic. Don’t keep replaying the 
incident and ratcheting up your bitterness toward the person. Talk 
to someone outside the organization if you need to vent.

MoVE ToWARD A SoLUTIon
Ready to make progress? Remember: people are not perfect—you 
or them. When criticism comes your way, admit when you are 
wrong. Just say, “Well, that did not work like I thought it would.” 
Do not force blame onto them. They may have done some crazy 
wrong stuff, but they thought it would work. They may not know 
how to use a specific tool the right way, but they just need more 

guidance or training. Ask them if they might be open to suggestions 
on how to try another method. 

AfTER ThE SToRM PASSES
Don’t worry about how you look. You have a track record of 
success—one or two negative comments will not derail your 
career. People on staff know that you get things done. They 
know you make good decisions. They are convinced by your past 
record of wins that you are the “go to” person. A few bumps can 
be forgiven. Don’t worry too much about complaints.  It’s not a  
big deal.

Take away the gold nuggets. Try to address the items of truth 
mixed in with the rants. Hints at troubles come under the breath. 
Listen to murmuring and you can avoid the shouting. There is 
always some area to improve on. Some area to review again. Some 
tech that has languished too long. Look at the choppy water as 
an opportunity to tune your navigation skills. Learn from it. Get 
stronger. Thicken your skin.

Mark Kiker has more than 25 years 
of hands-on experience with technol-
ogy. He is fully versed in every area of 
management from deployment plan-
ning, installation, and configuration 
to training and strategic planning. As 
an internationally known speaker and 
writer, he is a returning speaker at  
Autodesk University since 1996. 
Mark is currently serving as Direc-
tor of IT for SIATech, a non-profit 
public charter high school focused on 
dropout recovery. He maintains two 
blog sites, www.caddmanager.com and  
www.bimmanager.com.

CAD Manager

hAVInG ThICk SkIn MEAnS 

yoU ARE noT EASILy 

InSULTED, hURT, oR UPSET. 

IT MEAnS ThAT yoU Don’T 

EASILy AnGER. yoU ARE noT 

EASILy offEnDED By ThE 

CoMMEnTS of oThERS.
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S
tatements like these, borne out of inspiration 
(or frustration), are the seeds of innovation 
and progress. Sometimes, we can take 
matters into our own hands, inspired to 

create or driven to find a solution of our own. Other 
times, we are limited to just accepting, complaining, or suggesting. 

In our professional lives as Autodesk product 
users, how do we get from “Wouldn’t it be nice 
if…” to “That’s a great feature!”? Enter the AUGI 
Wish List, your proverbial megaphone to let 
Autodesk know what you want.

ThE BACk SToRy
The AUGI Wish List (www.augi.com/wish-list) predates 
AUGI itself, having its roots in the mid-1990s, back when the 
organization was known as NAAUG, the North American 
Autodesk User Group. At that time, the Wish List served as 
one of the few channels through which users could make their 
desires known to Autodesk. It received a major overhaul back 
in 2011 and continues to evolve as one of AUGI’s primary  
member benefits. 

Technology has since enabled Autodesk to shorten the distance 
to users, creating additional paths to engage, interact, and hear 
from its customer base through programs such as the Feedback 

Influence 
Autodesk’s 
Tomorrow

➲

“Wouldn’t it be nice if…” 
“Here’s an idea…”

12

http://www.augi.com
http://www.augi.com/wish-list


October 2018 www.augiworld.com 13

Wish List C
O

L
U

M
N

Community (beta.autodesk.com), the Autodesk Product Feedback 
page (autodesk.com/company/contact-us/product-feedback), 
and various product-specific IdeaStations (forums.autodesk.com). 
Autodesk also connects with customers more directly via surveys, 
customer interviews, site visits, as well as group and one-on-one 
feedback sessions at Autodesk University.

Even with all these other venues, Autodesk still proudly cites 
the AUGI Wishes “granted” in their new product marketing. 
And there have been quite a few granted! According to  
AUGI’s Hall of Fame (augi.com/wish-list/hall-of-fame), there 
have been more than 800 wishes that have made their way into 
Autodesk products. As far as I can tell, AutoCAD 2009 has the 
distinction of being shipped with the most granted wishes in one 
release: 17!

oUR CoLLECTIVE VoICE
At each step in the Wish List process, AUGI and Autodesk rely on 
our members, and their customers, to move wishes through their 
lifecycle, from inspiration to implementation. Let’s take a deeper 
look at each of the steps shown in this overview diagram: 

Submit – The next time you have one of those “It would be cool 
if…” thoughts, jump on over to augi.com/wish-list and click the 
“Make A Wish” link. Select the desired product (Note: the list of 
products you see is determined by the “Products I Use” list in your 
profile). Before submitting your wish, enter a search term related 
to your idea to see if a related wish already exists in the system, 
thus preventing duplicate wishes. If the search returns a wish that 
looks similar, you can throw your support behind it by ranking 
it (we’ll explain that next) or see what has been discussed about 
it in the related forum thread. If your wish is unique, you can 
proceed using the “Submit Your Idea” link. Be sure to enhance the 
description of your wish by using examples and adding hyperlinks. 
Unfortunately, it’s not possible (at this time) to add images, but 
you could always create a Screencast and place the link in your 
description if that would be helpful.

Once this initial step has been taken, it’s now time for the 
membership to get involved and add value to the remaining steps. 

Rank – The purpose of ranking is to whittle the magnitude of 
wishes down to your “top 30.” Ranking is done via the sliding scale 
shown below: 

In addition, three other options are available:

1. Engage with other members in the wish’s forum thread to:
•	 Discuss the wish to clarify or expand on the  

requested feature.
•	 Share and brainstorm workarounds (hopefully temporary 

ones!) to be used while waiting for the wish to be granted.  
•	 Share solutions that are available from other users  

or developers. 

2. Mark wishes that may already exist in the product.

3. Flag wishes for removal from the Wish List.

I’m not gonna lie—ranking wishes is addictive! Since wishes are 
presented randomly, it’s fun to see what will show up next. During 
your next break, why not influence the productivity software of 
tomorrow rather than mindlessly scrolling Instagram? 

Vote – The Vote page presents you with the currently ranked top 
30 list and asks you to select your ten favs! Just picking the top 
ten, however, still doesn’t give Autodesk quite enough information 
because they’re not in any particular order. Yet.

Buy – It’s time to “put your money where your mouth is,” as the 
saying goes. Buying is the final and crucial step. Each AUGI 
member has $500 in “wish cash” that they can distribute among 
the ten wishes. The allocation of funds prioritizes the top ten into 
their order of importance.

Present – Autodesk product developers have year-round access 
to the Wish List and can, at their discretion, take action on any 
wish. The official hand-off, though, occurs at the AUGI General, 
Meeting held in conjunction with Autodesk University each 
year. During the AGM, an Autodesk product representative is 
presented with their respective Top Ten list. 

WISh LIST PLAyoffS
Too many steps, you say? Frankly, I thought so too 
at first. Amazing what a little research (writing 
this article) does to changing one’s perspective. It 
might help if you think of these steps as rounds 
in a sports playoff system: quarter-finals (ranking), semi-finals 
(voting), and the final (buying). Unlike a playoff system, the Top 

http://www.augiworld.com
file:///C:\Users\Customer\Downloads\augi.com\wish-list
https://screencast.autodesk.com
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Ten is dynamic; it is recalculated each week based on the “buys” of 
the AUGI community. So, if a few wishes you had previously put 
money on have been “voted off the island” so to speak, the funds 
you had spent on those wishes is now free to be reallocated among 
the new Top Ten. AUGI will let you know this via a “You have 
new wish dollars to spend…” email. Additionally, you can always 
reallocate your wish cash at any time.

MAkInG ThE CUT
So, now that the AUGI community has done its part and handed 
everything over to Autodesk, what’s next? Well, there are no 
guarantees that your wish will make the cut, but the 800+ wishes 
granted is promising! Ultimately, though, Autodesk gets the  
last say. 

Timing also plays a part in when, and which, wishes are 
implemented. A wish submitted later in the year, even with lots 
of buys, is very unlikely to appear in the very next release of a 
product. Autodesk is already working on future product releases, 
so wishes may have to wait a release cycle or two before they can 
appear in product. 

How, then, does Autodesk decide? How are the wishes weighted? 
I had the privilege to speak with Autodesk’s Brad Holden, Product 
Manager for AutoCAD platform. He mentioned a number of 
factors that Autodesk takes into consideration when processing 
feature requests.

•	 Pervasiveness – What percentage of users are affected by this 
issue?

•	 Frequency – How often do users run into this issue?
•	 Severity – How big of a problem is this issue?
•	 Strategy – How does this request fit into Autodesk’s overall 

strategy for the product?
•	 Feasibility – From an engineering perspective, is it even 

possible? 

For the most part, strategy and feasibility are 
outside the direct influence of the Wish List. The 
other three factors—pervasiveness, frequency, and 
severity—are much more directly linked to it. The 
Rank/Vote/Buy process is a very effective way for 
Autodesk to determine these factors. Pervasiveness is inferred by 
the number of members that buy each wish. And, as Holden also 
noted, “The ‘Buy’ feature helps Autodesk because each individual 
user is going to optimize how they spend their money based on the 
severity and frequency of the problems they face.”

GET InVoLVED
The Wish List system is only as effective as the participation of 
the AUGI membership. The system doesn’t operate autonomously. 
In addition to participating in the Rank/Vote/Buy process, 
AUGI needs volunteers to help review and vet wishes as well. 
According to Wish List Manager, Rick McNeil, “We receive about 
30 wishes per day, so having a handful of reliable volunteers is 
extremely beneficial.” Sometimes wishes that are submitted from 
our international members may have language translation issues 

to address. Additionally, a wish submitted in an industry-specific 
“language” may require a volunteer with experience in that industry 
to translate it into more general language. If you consider yourself 
an SME (subject matter expert) in one of the seven different 
product Wish Lists (AutoCAD, Civil 3D, Inventor, Revit, Revit 
Architecture, Revit Structure, and Revit MEP) and are willing to 
give back to AUGI an hour or two a week, it would be a huge help. 
Just send an email to volunteering@augi.com to get plugged in.

ConCLUSIon
A number of AUGI’s programs are designed to provide value 
primarily to the members. The Wish List, however, has the unique 
characteristic of having value not only for our members, but also 
for Autodesk and their product development teams. 

It is AUGI’s desire that the Wish List continues to be relevant to 
all parties. We are committed to doing our part by growing and 
improving the Wish List system. As a result, we hope it continues 
to be an “idea super highway” linking the innovative ideas of the 
users with the development resources within Autodesk. 

Chris Lindner is a 30+ year Auto-
CAD user, working primarily in the 
architecture industry. He has worked 
as a drafter, IT manager, trainer, pro-
grammer, and Autodesk consultant for 
notable companies such as Kroger, L 
Brands, and Huntington Bank. He 
currently serves as Treasurer on the 
AUGI Board of Directors, was a mem-
ber of Autodesk’s AutoCAD Men-
tor team, and is a returning speaker 
at Autodesk University. Chris is the 
CAD Manager for Shremshock Ar-
chitects & Engineers in central Ohio. 
He can be reached via email at chris.
lindner@augi.com.
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by: Joshua Geimecke

C
ustomization can be helpful, but it can also 
be detrimental to a workflow.  Instead of 
looking at actual cases of customization, 
let’s consider this argument: to customize 

or not.

WhAT IS CUSToMIzATIon?  
As I often like to do when looking into these types of topics, I list 
the definition. Customization is the action of modifying something 
to suit a particular individual or task.  Obviously in this case, the 
something in this conversation is going to be the software and the 
people using it.

There are many different types of customization that can be 
applied to Autodesk software.  If you do a Google search for 
Autodesk customization, you will get a few (hundred thousand) 
returns on the search.  Autodesk does their own customization, 

companies specialize in doing customization, users can create their 
own customization, and so on. 

IS CUSToMIzATIon A GooD ThInG oR 
A BAD ThInG? 
There are good and bad uses of customization.  Early in my career 
I worked for a company that had purchased a customized toolbar 
that ran in AutoCAD® to apply all company standards and layers 
as well as typically used blocks.  This tool was very helpful for the 
speed of the workflow, but when it broke, it destroyed the workflow.  
The problem was the CAD users had grown so accustomed to 
using only that toolbar to set their layers that they forgot how to 
do it natively in AutoCAD.

Customization is good when it helps improve the workflow and 
the time to deliver  the client a finished project.  It can be helpful on 
a repetitive task that takes a tremendous amount of time.

To
Customize
or not

➲

http://www.augi.com


October 2018 www.augiworld.com

Revit 2019 – Structure P
R

O
D

U
C

T
 F

O
C

U
S 

17

It can be bad when it “dumbs down” the person using the software, 
much like at that job from years ago.  If the person can’t utilize the 
native software without the customization, then we are doing a 
huge disservice to the user.  If the customization doesn’t work, and 
the user can’t work without it, then nothing gets done and it will 
definitely impede the workflow and the deliverable for the client.  
We are always looking for ways to speed up the process, because 
time is money and we want to get the project out the door on time 
or early, but at what cost?

IS ThERE A DIffEREnCE 
BETWEEn PERSonALIzATIon AnD 
CUSToMIzATIon?
The simple answer is: absolutely.  Most software users customize 
their toolbars, ribbons, and tool palettes to work in the most 
efficient way for them. Who amongst us hasn’t changed the 
keyboard shortcuts to work in a way that makes sense to us? Who 
amongst us hasn’t panicked when we upgraded and our shortcuts 
don’t work anymore?

Can there be over-personalization?  Again, the simple answer is: 
absolutely.  As a CAD/BIM Manager, I can attest that working 
on someone’s machine that has been over-personalized can be 
frustrating, especially if the user isn’t available to walk you through 
it.  Sometimes over-personalization can cause programs to not 
work properly or even crash.

Am I against personalization?  Simple answer: absolutely not.  I 
do it with my software, but I still want people to be able to use 
my software if they need to.  Remember when the ribbons were 
updated in Autodesk software and many people immediately 
reverted to the old style?  Over-personalization can make the 
software unfamiliar to other users, much like the ribbons did when 
they appeared on that new install.

IS AUToMATIon A foRM of 
CUSToMIzATIon? 
Where does automation fall into this?  Writing routines and 
scripts, using programs like Dynamo?  Is this customization or is 
this a tool that helps the workflow? Utilizing automation to make 
your workflow more efficient is a good thing.  Taking the mundane 
and assigning automation to it is beneficial as well.  These tools 
were designed with the intent of helping the processes we have in 
place, not replacing them and eliminating the important part—the 
person behind the computer.

ConTEnT CUSToMIzATIon? 
When I think of content customization, I think of all the vendors 
in the market that supply content for use in models.  I think of all 
the companies that produce lights, HVAC equipment, plumbing 
fixtures, and the like. I think of the disappointment when I can’t 
find anything but a 2D CAD or PDF of a family!  

This customization is super beneficial to a project and really gives 
an owner a great expectation of what the completed project will 
look like.  It also aids in the coordination of projects, when you 

have devices that are graphically and dimensionally accurate so you 
know how tight you can make an area.  Also, when the connections 
of these families are accurate, you know where your supplies and 
returns are coming and going.  We need more customization of 
families and the like to be incorporated into a model.

ConCLUSIon
This is a short article and just grazes the surface of customization.  
So what is the answer “to customize or not”?  The answer is yes, to 
the extent that it benefits your process, your workflow, your client’s 
expectations, and your overall deliverable of a project.  

To customize for the sake of customization isn’t a good reason.  
I believe that you must reap a benefit from the customization 
that has been sown in a tangible way so as to benefit the overall 
project and client.  Remember, you could get run over by a bus 
and someone else is going to work on your computer, with your 
software on your project—make it so all can jump in and run with 
it.  Think of the overall team and the process of the project so all 
parties can play well together.  Until next time, happy customizing 
and collaborating!

Joshua Geimecke is the Technical Di-
rector of the Mid-Atlantic Region 
for EDGE-GTS, headquartered in 
Rochester, New York. He leads a 
group that specializes in BIM, IPD, 
VDC, and all facets of design tech-
nology. Joshua has been involved in 
the AEC industry, working in many 
different disciplines and sectors, 
for more than 18 years. He can be 
reached for comments and questions at  
jgeimecke@edge-gts.com.
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I
t is helpful to understand ways we can customize 
3ds Max® where it makes sense to customize 
it for our needs. This article focuses on some 
of the ways that are helpful, regardless of the 

product we provide. I’ll focus on templates, startup 
files, toolbars, and end on a note concerning content.

TEMPLATES
Preparing scenes with the proper environments and render settings 
is time consuming. With customized templates, we can store those 

we collect and create. Additionally, with repetition, our abilities 
grow and we can improve and refine these templates. Over time, 
we collect a library of templates for a variety of scenes and settings 
that allows us to produce the highest quality content we can in a 
shorter amount of time. 

Refer to Figure 1 where you’ll see I set up a file for mechanical 
rendering that shares my favorite materials, render settings, some 
kitbash elements, and an environment for a presentation that 
includes lights, a surface plane, and camera. Now I’m able to start a 

by:  Brian Chapman 

Customization 
with 3ds Max   

➲

Figure 1: Add Template
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project using this file at any time. The steps to generate a template 
are simple and marked in Figure 1. First, select the File Menu, 
then choose New From Template. Second, choose Open Template 
Manager on the Create New Scene palette. The third and final 
step is to fill out the information about the file you have open and 
then select Add New. 

See Figure 2 for a few examples of templates I use to assist with 
the development. 

CUSToMIzE ThE STARTUP
Customizing the startup file allows us to begin our 3ds Max 
sessions with preferred settings. For example, let’s say we work 
primarily with Vray and wish to open 3ds Max to see our material 
editor already slotted with default Vray materials. We can do this 
by opening or setting up a file the way we prefer, then saving it 
in the MaxStart folder called “maxstart.max.” You can locate the 
MaxStart folder by navigating to the Configure User Paths option 
in the menus under File > I/O Panel. 

CUSToM TooLBARS
Creating custom toolbars in 3ds Max is an excellent alternative to 
access tools we use most often. Toolbar creation is simple. First, 
select Customize User Interface in the Customize menu. You can 
now create your toolbar following the steps in Figure 3.

Step 1, select the toolbar panel. Step 2, select the New button. 
Step 3, type the name of your toolbar. Finally, in Step 4, drag 
commands from the action panel into your toolbar. When 
done adding commands to the toolbar, select the save option  

at the bottom.

CUSToMIzE ConTEnT
Prepacked solutions gave us the ability to 
generate content quickly and efficiently. 
Advances in technology such as RT 
rendering in 3ds Max and Datasmith for 
Unreal Engine leave us only a few short 
years from real-time rendering solutions. 
The geniuses at companies such as 
Autodesk, Chaos, Pixologic, NVIDIA, 
Intel, and more have evolved the industry 
so far that in a few short years generating 
realistic content becomes as simple as 
playing a game of Sim City, leading to 
savings for clients and helping teams to 
be more efficient. 

With all of this, there is potentially a 
downside to the automation that we’ve 
already started to experience. Generally 
speaking, content looks the same. 
While this is extremely efficient, many 
of us wish to avoid this. A powerful way 
to do that is to create custom textures 
and materials. Refer to Figure 4 for an 
example of some custom textures. 

Figure 2: Template examples

Figure 3: Creating a custom toolbar
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Thankfully, there are programs built to help us generate these 
textures for 3ds Max. For this article, I’ll present PixPlant. 
PixPlant allows us to select a picture (or existing texture 
file) and uses various algorithms to extract a color (diffuse), 

displacement, normal, specular, and ambient occlusion 
map. Perfect for building materials in 3ds Max.  
See Figure 5 for example.

PixPlant gives us options to help manipulate the 
image so that it’s seamless and repeatable and adjust 
each of the individual maps to suit our needs. As you 
dive into the texture-development world, you’ll want 
to study more on the removal of lighting sources and 
shadows, the types of images to use, quality, and more, 
but for most cases, this software is a powerful way to 
help us generate unique and personalized content that 
satisfies our creative drive. 

Ending on this note: remember that customizing our 
experience and tools in 3ds Max is useless if it’s not 
leading to improvements. 

Brian Chapman is an 
Autodesk Authorized 
Developer, creator of 
Pro-Cad.Net and a Se-
nior Designer for an 
engineering firm located 
in Las Vegas, Nevada. 
Brian can be reached at 
procadman@pro-cad.
net.

Figure 5: PixPlant texture creation

Figure 4: Custom textures

http://www.augi.com
mailto:procadman@pro-cad.net
mailto:procadman@pro-cad.net




www.augi.com October 2018

AutoCAD 2019  
P

R
O

D
U

C
T

 F
O

C
U

S 

22

by: Jisell Howe

F
or a CAD manager, customizing software to 
better suit designers’ needs can be such an 
exciting task. I am often asked for creative 
solutions to get the product we manufacture 

to function properly in software so our customers can 
easily specify it and use it in hydronic heating and plumbing designs.

One of the customized solutions I configured in recent years for 
my company’s design team was an AutoCAD® MEP tool palette 
with pop-up menus. To do that, I learned how the Customize User 
Interface (CUI) Editor worked within AutoCAD. This article will 
show what I learned and, hopefully, inspire you to come up with 

your own customized solutions for your design team no matter 
what AutoCAD product you use.

The first thing to understand is that the CUI Editor is a very 
powerful tool within AutoCAD. There are many components 
within it that help make up the end user experience. Knowing 
this, you can roll out your company standards within this  
end user experience. 

The CUI Editor can create and manage the following customization 
file types: Main, Enterprise, and Partial. For the purpose of this 
article, I will focus mainly on editing an Enterprise customization 

➲

Destination 
Customization: 
Customized Solutions 
for AutoCAD
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file that will roll out the customizations. To access the CUI Editor, 
simply type CUI in the command line (see Figure 1).

A. This section displays CUIx files as well as a tree of all areas to 
customize. Figure 1 shows a Main CUIx file and an Enterprise 
read-only CUIx file loaded. If I want to edit the Enterprise file 
where all my customizations are, I need to designate it as the 
main CUIx in AutoCAD Options > Files > Customization 
Files as shown in Figure 1. In other words, I just browse out 
to the file in AutoCAD Options, so it becomes editable in the 
CUI Editor. 

B. This section lists all 
the commands. It allows 
out-of-box commands as 
well as custom commands. 
You can drag and drop 
these commands into all 
sorts of menus, toolbars, 
etc. as well as tool palettes 
outside of the CUI Editor. 
Note that you can only drag 
and drop the commands 
in the CUIx file that is  
currently editable.

C. This section 
includes all the properties 
associated with any 
given command in your 
command list. They may 
appear grayed out if they 
were created while your 
Enterprise file was being 
edited (which is the case in 
Figure 1). However, when 
the fields are not grayed out 
and that CUIx is editable, 
they can be edited. When I 
create a “custom” command, 
I specify the following:
•	 Name
•	 Description
•	 Command Display 

Name
•	 Macro (what you want 

this command to do)
•	 Image (you can pick 

existing ones or specify 
your own)

Now that we have an 
overview of the CUI Editor 
and its components, let’s 
look at how it affects the 
end user experience. See 
Figure 2 for an example of 
how the components in the 
CUI Editor make up the 

Build panel on the Home tab within the Piping workspace that is 
set as current in the Main MEP CUIx file. Note that the example 
shown is within AutoCAD MEP, but the same concepts still apply.

Understanding the CUI Editor will help you recognize patterns 
so you can create your own ribbon panels, menus, toolbars, or 
anything else to suit your designers’ needs. Recognizing patterns 
of what is already built will help you provide customized solutions 
much faster than starting from scratch. 

Figure 1:  CUI Editor overview
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Figure 2 shows how each tool or command is organized and 
grouped in the CUI Editor to appear a certain way in the ribbon. 
Commands are listed as stars; you can drag and drop from Section 
B to Section A and establish hierarchies of tools by right-clicking 
within Section A for different options (refer to Figure 1). 

Sub-panels, rows, and line separators are just some of the tools 
that can organize the commands. Please keep in mind that your 
custom edits do not need to be this complex. This is simply an 
example of the power behind the CUI Editor.

Let’s take it a step further and look at another 
way to customize the end user experience using 
the CUI Editor and a tool palette. Tool palettes 
are influenced by multiple file types to properly 
display. While there are various file types that can 
influence the look and feel of a tool palette, I will 
focus on a few types to get the ball rolling. 

The first type of file is for the tool palette itself 
(.atc). All created tool palettes generate an .atc 
file in your AutoCAD Support Files > Palettes 
location, likely on your local drive. The second 
type of file is the tool palette group profile (.aws) 
that remembers all the tool palettes and the order 
of the tools within them. This is located in your 
AutoCAD Support Files > Profiles location. 

The final major type of file is the master ATC file 
(.atc) that remembers all the tool palettes and all 
the tool palette groups. This file, which can vary 
by name depending on the AutoCAD product 
you are using, is located in the AutoCAD Support 
Files just outside of the actual Tool Palettes folder. 

I don’t modify this file in any way, but I wanted 
to mention it as part of the hierarchy. Other file 
types such as images (.bmp, .png), block drawings 
(.dwg), and more can all be used within tool 
palettes once you establish those first few tool 
palette files.

Refer to AutoCAD Options > Files > Support 
File Search Path for a general path to these 
previously mentioned support files. Depending 
on your AutoCAD product, the exact folder 
names for tool palettes and other items may vary 
slightly after that point. When in doubt, refer to 
AutoCAD Options > Files to verify Tool Palette 
File Locations and more. 

To create a tool palette for the first time, you 
must first go into AutoCAD Options to create 
a New Profile to set as current. This might seem 
like an extra step, but I do this because I want to 
make sure the file locations that are specified in 
AutoCAD Options for these new tool palettes are 
correct and that the files are generating properly 
as I go. 

I’ve spent many hours wondering why my new tool palettes weren’t 
generating the .atc and .aws files, only to find out the file location 
I specified for these tool palettes didn’t have writing permissions 
to be able to automatically write there. I’m mentioning this to save 
you some of the potential frustration if you decide to change the 
Tool Palette File Locations in AutoCAD Options > Files to be 
something other than the out-of-box location. 

Figure 2: CUI editing example
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Once you confirm your Tool Palette File Locations in AutoCAD 
Options, type TOOLPALETTES in the command line 
and right-click on the current palette to go to Customize 
Palettes where you can create a New Group and a New Palette  
(see Figure 3). 

It’s important to name them right away because these tool palette 
files should now be generating in your AutoCAD Support files. 
Confirm that they are showing up in the locations you specified 
in the Tool Palette File Locations in AutoCAD Options. If 
you ultimately see .atc files and .aws folders named the way you 
intended in those locations, you are golden. Then the fun begins.

At this point you may set 
this new tool palette group as 
current within the Customize 
Tool Palette window. From 
there you will have a blank 
slate where you can do any of 
the following:
a. Drag/drop drawing blocks 
to your tool palette.

b. Drag/drop commands from 
CUI, CONTENTBROWSER, 
or current drawing into your tool 
palette.

c. Configure macros in 
commands and add to your 
tool palette.

d. Add documents to 
buttons in your tool palette 
(i.e., User Manual or Company 
Standards) via the tool palette 
button properties.

e. Create custom images for 
your tool palette buttons.

For the purpose of this article, I 
will focus on command macros 
that ultimately create a pop-up 
menu within the tool palette. 
I did this for my company’s 
designers because we were 
utilizing many different routing 
preferences and systems for 
pipe drawing with our product 
within AutoCAD MEP. Even 
though this article will show 
that specific example, you can 
create macros and pop-up 
menus for any selection of 
commands you’d like to neatly 
organize in a tool palette.

One way to create a command 
macro is to hardcode one in 
within the CUI Editor. Be sure 

to use proper syntax and pay attention to the different options 
you already specified when using commands. You can find a table 
of proper syntax for macros when looking up the help files (F1) 
within AutoCAD itself. 

See Figure 4 for an example of a command macro I created based 
on what I saw in the command line. I essentially specified that I 
wanted the PIPEADD command to engage, and then I specified 
the routing preference and the system I wanted the command to 
draw with. 

Figure 3:  New tool palette
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These things I specified show 
up in the command line as 
highlighted letters, just like any 
other command that has options 
for you.  The whole purpose 
of macros is to help automate 
commands, so you don’t have to 
keep specifying and typing those 
commands out each time.

Once you have written some 
macros in newly created 
commands within the CUI 
Editor, you can then drag and 
drop them from Section B to 
Section A under the Menus area 
(see Figure 5). You can use line 
separators to create a cleaner and 
more organized look within the 
menu as well. 

Right-click to see your options. 
Once you build your menu, look 
at Section C to assign an alias 
for it. This alias will be used 
to call the menu in a DIESEL 
expression to ultimately make 
all those command macros pop 
up in the properties of a tool  
palette button. Figure 4: Creating a macro

Figure 5: Building a menu
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Now it’s time to put it all together. To review, we created commands 
using macro syntax and placed them under a menu in the tree of 
customizable options in the CUI Editor. We then spelled out the 
alias of that menu so we could eventually put it in the tool palette 
to make that menu pop up with all those commands. 

For the last step, we’ll specify the DIESEL expression that calls 
this menu in the tool palette. Go to a tool palette button on the tool 
palette itself and right-click to get into the Properties. Specify the 
highlighted settings in Figure 5 (and modify to suit your needs). 

While DIESEL itself is a big topic all on its own, the point is that 
it is specifying a menu listed under a certain CUIx file. For my 
example in Figure 5, “Uponor” is an Enterprise CUIx file I made 
editable and “domesticcoldwater” is a menu I created in the CUI 
Editor with several different commands within it. 

Type out the expression with characters and spaces as shown, 
and you will then have a pop-up menu in the properties of one 
tool palette button. See Figure 6 for a final result of building a 
tool palette, creating some command macros in the CUI Editor, 
putting those commands in a menu under an editable Enterprise 
CUIx file, and lastly, making that menu pop up in just one of the 
tool palette buttons. 

As I mentioned in the beginning, 
customizing software to suit designer 
needs can be very exciting. Creating 
solutions for our designers has been 
very rewarding for me as a CAD 
administrator. My hope is that these 
brief examples will help you expand 
your horizons and inspire you to come 
up with ways to address the needs of 
your designers. 

Before I wrap this up, I do want to 
mention that multiple files need to 
be carefully deployed so everyone 
can see these new tool palettes and 
other customizations. Please check 
out my article “Seven Songs about 
Scripts” in the July 2017 issue of 
AUGIWorld magazine to read about 
ways to deploy all these different files 
and customizations to your designers. 
Happy customizing!

Jisell Howe, CDT, is the CAD Ad-
ministrator for Uponor, a PEX pipe 
system manufacturing company locat-
ed in Apple Valley, Minnesota. As an 
AutoCAD certified professional, she 
manages several internal and external 
product/content databases and sup-
ports the software needs for 40 design-
ers in the company’s Design Services 
department. Jisell holds a Bachelor of 
Science degree in Applied Manage-
ment as well as an Associate of Ap-
plied Science in Architectural Drafting 
& Estimating from Dunwoody Col-
lege of Technology. She is a returning 
speaker for Midwest University, a re-
gional professional development con-
ference featuring Autodesk® software. 
Jisell can be reached for questions and 
comments at jisell.howe@uponor.com.

Figure 6: Pop-up menu in the tool palette
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Risers 
and  
one-Line 
Diagrams:  
not Just a  
one-Way Street

by: Nathan Mulder

http://www.augi.com


October 2018 www.augiworld.com

Revit 2019 – MEP P
R

O
D

U
C

T
 F

O
C

U
S 

29

T
he theme for this month’s issue is 
customization. This can mean different 
things to different people. It could be as 
straightforward as reviewing the options 

and features provided with the software to flex to your 
way of working. For example, things such as modifying the user 
interface, keyboard shortcuts, quick access toolbar, etc; a sort of tips  
and tricks.

Another common form of customization is extending the 
functionality of Autodesk® Revit® via the API. This is perhaps 
what most people think of when the topic is customizing Revit. 
There is no shortage of great add-ins, macros, and Dynamo scripts 
to customize Revit—achieving things the software can’t do out of 
the box, but using the information already contained in the model. 
If you can’t find what you need freely available or for purchase, 
there is an active community that can help you build your own.

A third type of customization is the infamous Revit “workaround.” 
These are the contrived workflows to achieve a desired result that 
the software either doesn’t support at all or not well enough. These 
usually involve either taking advantage of a bug or anomaly in 
Revit or using a built-in feature in a way that wasn’t exactly its 
intended purpose. 

In the September 2018 issue of AUGIWorld, we discussed a 
specific type of workaround for legends—an often overlooked but 
essential tool when creating construction documents. We covered 
the basic purpose of a legend, looked at the built-in functionality 
provided with Revit to create legends, and discussed alternatives 
when the provided tools may not meet your needs.

Building on that article I want to review another contentious issue 
for those on the engineering side of the fence: risers, one-line 
diagrams, and single-line diagrams, etc. They have many names 
and slightly different goals, but the basic idea is the same: they are 
a 2D schematic or diagrammatic depiction of a system’s design. 
By definition this differentiates them from plan drawings because 
routing information is not included and not all connections are 
necessarily shown. Or, in some cases, more information is included 
that is not shown on the plans.

I think most would argue that risers and one-line diagrams are 
technically different. A riser is used to indicate connections of a system 
as it travels vertically through a building, perhaps only displaying the 
major components. In an HVAC riser, for example, while showing 
connections between equipment across levels, the more numerous 
connections to air terminals are usually not included.

A single-line diagram, by comparison, is most commonly used by 
electrical trades to indicate connections between equipment and 
various components. They graphically depict the flow and electrical 
data of the system without necessarily indicating the location of 
the components.

Plumbing also has its version of risers or isometric drawings 
indicating connections to fixtures. These typically provide and 
show information that is difficult to indicate in plan view. With 
careful planning and implementation, a 3D view or views can be 
used to achieve an isometric directly from the model.

As with our previous discussion of legends, fundamental questions 
should be asked when thinking about risers and line diagrams. 
Does the diagram need to use information from the model, 
reducing duplicate work and data entry? Or can the diagrams 
be more “typical,” not necessarily having to stay coordinated with 
changing information in the model? Having answered these 
questions, this article will investigate some of the options available 
in Revit for engineering designers.

At this point it is also worth asking an even more basic question: 
what role do these diagrams play in designing engineering services 
for a building? Should the riser or one line summarize what is in 
the model or should it drive what is input into the model? In other 
words, what comes first, the diagram or the model?

In my opinion, Revit is more of a modeling and construction 
document tool than an engineering tool. It does not natively allow 
for driving the model from diagrams. But that doesn’t mean it isn’t 
possible. Via the API or even Dynamo, a lot of data and automation 
can be pushed around. There are also third-party solutions that 
both extend the engineering design using information from the 
model or are able to drive the model from the information and 
layouts performed in their software first.

➲

Figure 1
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Still a summarization of what has already been modeled and 
assigned to a system, Revit has what is called the system browser 
(and system or circuit schedules to a certain degree – Figure 1).

The system browser is helpful for basic tasks like seeing a tree view 
of connected items, isolating and editing elements on a system, and 
finding elements not assigned to a system (Figure 2).

Sadly, its usefulness stops there. All that information available for 
assisting in creating diagrams! Understandably, risers and diagrams 
quickly get complicated when considering the myriad standards 
and requirements each company, discipline, and permitting agency 
may have. However, I believe it can be framed another way as well. 
Revit itself provides the technology and tools to create models 
and construction documents, but leaves many of the “last mile” 
decisions such as symbols, appearance, etc, up to the user. The same 
approach can be used on the system browser with risers and line 
diagrams. The underlying technology and information is already 
there in the system browser—we just need a few more tools to 
assist the user in going the “last mile.” This is an area I hope to  
see explored.

So we’ve concluded that Revit doesn’t provide a way to start with 
a diagram and drive the model from there. We’ve also concluded 
that the system browser won’t help us much in summarizing what 
is in the model by creating risers or line diagrams. Where do we 
go from here?

One approach is or was to continue drawing the riser or line 
diagram in AutoCAD® or other software. This information was 
then linked in as a DWG to a Revit drafting view. All the standard 
symbols were already built and it was a tried-and-true process. 
Why reinvent the wheel?

I see the above approach as a stepping stone to the next option: 
creating the diagram in a drafting view in Revit. After all, Revit can 
draw lines, text, and symbols just like AutoCAD, so why not keep 

it all in Revit? True—detail items, tags, and generic annotations 
need to be created, but once complete there is a lot to gain from this 
approach as opposed to continuing to link in DWGs. Parameters, 
tagging, and even schedule-specific views or elements are a few 
examples, not to mention eliminating the hassle of opening and 
modifying the information in another piece of software and then 
having to reload, all just to see a change.

It should come as no surprise that the above options are not 
using actual model information. All that parameter and system 
information from those model elements, but no way to get to it 
for a diagram. What a shame! Remember those fundamental 
questions we raised earlier?  If your riser or diagram is more typical 
in nature—not indicating actual element properties or system 
information from the model—then a drafting view is a good choice.

However, what if you do want model information to be coordinated 
with the diagram(s) in your drafting view? Obviously, you can 
do it manually. Had to renumber your chillers or air handlers? 
Don’t forget to do it on your riser. That’s no fun. This is where 
customization is required. 

Still making use of drafting views there is an approach that can 
help automate this process. With the API or Dynamo, it is possible 
to create parameter relationships between elements. I personally 
use a paid add-in for such purposes. Once the relationship is 
established, any change in parameter values in either the model or 
the drafting view updates the other.

If you are fortunate enough to have an in-house person or 
department capable of programming this functionality into an 
add-in, macro, or script, the features can be even more automated 
and customized to your company’s workflows. This approach 
perhaps requires the most time to implement, but the returns can 
be fantastic. I’m a big fan of preservation of data and minimizing 
duplicate data entry. Just think, once in place, no more chasing 
your tail around trying to remember where to update information.

Figure 2
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This gets us to our last “type” of customization: workarounds. The 
dilemma here most often boils down to these two points: 1) All the 
information needed for the riser or diagram is in the model; and 2) 
The technological know-how to coordinate this in a drafting view 
is beyond your abilities and time limits.

The first workaround option is to a create the riser or diagram in 
the model. Think about it—all the information is in the model. 
Why go through the effort of getting that information into a 
drafting view? A drafting view, by definition, is not tied to the 
model. So rather than bringing the information to the drafting 
view, we are bringing the graphical elements (lines, tags, detail 
items) to the model.

This approach has been around for a while and is well covered 
in previous AUGI publications. As such I will outline the basic 
steps but not go through the process in detail. The basic premise is 
that the information is in the model. We just need to display that 
parameter information suitable for the riser or diagram by using 
tags. What is needed then are tags created just for this purpose. 
They will include the parameter information we wish to display as 
well as the symbols and graphics we need to use.

If a riser is the desired result, an elevation or section is a good 
choice for the type of view to create for this purpose in the model. 
This way you can see levels, floors, even ceilings, if desired, as well 
as spaces or rooms. If level or floor information is not required, 
technically any model view type should also work.

In order for this approach to work, all model information needed 
in your riser or diagram must be visible in your view. This means 
check to make sure your view crops and offsets are not excluding 
any elements you need.

Because the model elements should not be moved, risking your 
plan views, the flexibility required to make the riser or diagram 
relies on tags. Tags can be moved independently of their model 

elements. Beginning with version 2017, tags can now be pinned 
and will not move even if the model element host moves. This 
enhanced functionality makes this approach much more attractive 
compared to previous Revit releases.

No riser or diagram is complete without lines to indicate the 
relationship between elements. Lines can be drawn in model views 
just like a drafting view. Keep in mind, however, that because the 
elements are tags we will not have snaps to help us snap the lines 
to the tags. Further, if these lines need to also “carry” information, 
perhaps about the system or circuit, line-based detail items can be 
used. These can hold information in parameters for tagging, can 
also be used by Revit keynotes, and can even be scheduled.

Lastly, because this is a model view it probably contains information 
we don’t want to see in our riser or diagram such as links, datum, 
and family geometry. If we don’t want to see most if not all of the 
model elements, we will need to control their visibility. Controlling 
the visibility of links and datum elements is easy. However, turning 
off visibility for model elements, either by turning off a category or 
using a filter, also will make the tag for said elements not visible. 
The solution is to override the color of all elements that need to be 
not visible, changing their color to white. This keeps the element 
from printing or plotting but keeps it visible so that the tag(s) also 
remain visible (Figure 3).

Once all view settings have been changed and configured as desired 
a view template can be saved for easy re-use.

Don’t forget this is a workaround—using functionality for 
something other than its intended purpose—so it is not without 
its drawbacks. First, as I already mentioned, inputting lines 
between tags does not offer snaps to help with alignment and 
appearance. The information is preserved at the expense of less  
graphical consistency.

Figure 3
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Second, the tags, with their desired parameters and graphics, must 
be created for just this purpose. The danger that creeps in here is 
when different symbols are needed for elements of the same Revit 
category. Nothing is preventing the user from tagging an element 
with a tag using the wrong symbol. Or, if during the course of 
design the element changes types, the symbols in plan view also 
change. The symbol in the tag in the riser or diagram will then be 
incorrect. This is not a big problem if your tags are not indicating 
different symbols.

Third, once tagged, all the tags must be manually moved to their 
desired locations. This can be tedious depending on the number of 
elements. Once located as desired, don’t forget to pin all your tags! 

Fourth, the scale of the view must be such that it will fit on a sheet. 
Decide this sooner rather than later to avoid having to adjust 
annotative elements if the view scale changes (Figure 4).

Fifth, but probably not last, is that this works well for risers or 
diagrams depicting major equipment connections of a system. 
But what if more elements are required than just the major 
connections? For instance, on a security design project, hundreds 
of elements are to be included in the riser, indicating device 
information and panel termination location. You may ask why that 
is even necessary, considering all that information is most likely 
already on plan or can be easily displayed in a schedule. To that I 
would say, “your words, my sentiment.” I would completely agree 
with you. This article would be over. And that’s not happening.

The above requirements are daunting. Either way you look at it, 
whether using a drafting view with parameters linked to model 
elements or creating a modified model view to serve as your riser or 
diagram, it is an arduous task. It is a regurgitation of information 
displayed differently. We needed another solution.

A coworker recently had a brilliant idea that we have now used on 
several projects. Making device schedules in Revit is as easy as pie, 
right? We already use schedules with images for our legends. The 
next natural step then is to make a schedule to be used as the riser!

Under the right conditions, using schedules this way can 
dramatically improve the riser creation process. Just like tags in 
modified elevation views or “smart” drafting views, parameter 
information is always up to date. However, an advantage is that it 

removes the need to manually place tags or detail items and order 
them, sometimes sequentially, as needed. The formatting abilities 
of schedules assist in standardizing appearance and alignment. 
Elements can be easily filtered, sorted, and grouped (Figure 5).

Once placed on a sheet, a schedule can be split, now allowing 
for dynamic column control and arrangement. The columns of 
the split schedule can be resized as needed to accommodate size 
restraints of the riser or sheet itself. A single schedule can be used, 
or another option is to use several schedules filtering by level, for 
example (Figure 6).

It is not a perfect solution, however. Because schedules can only be 
placed on sheets, any required lines must be drawn on the sheet 
directly. If information needs to be added to these lines, you must 
resort to text or generic annotations.

Figure 4

Figure 5
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A possible alternative to the limitation of detail lines, one I have 
not personally tested yet, would be to still create a drafting view 
where line-based detail items can be input. By placing the drafting 
view on the sheet, overlaying the schedule, and working through 
the viewport of the drafting view directly on the sheet, it may be 
possible to get the benefits of both worlds. This would allow for 
parameter information, keynoting, and tagging of the lines, but 
would rely on the schedule for the bulk of the information.

Were schedules intended to be used in this way? Probably not. 
Does it work? Absolutely. As long as we are producing construction 
documents, we will most likely have to continue issuing risers and 
line diagrams to convey information. Furthermore, as long as we 
continue to utilize software for those purposes, there will be the 
need for customization. If the tools provided don’t meet a need, we 
improvise by creating our own, adding more functionality to what 
is already there, or finding workarounds. 

Figure 6
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by: Bryson Anderson Project Management

I
ncreasingly, especially with Autodesk Industry 
Collections giving users access to 20+ 
applications, it’s not uncommon to have two 
or three versions of 10 or more Autodesk® 

products installed on a typical workstation. And each 
one of those products has language packs, libraries, 

enablers, add-ons etc. This can result in dozens of installed  
Autodesk applications. 

Installing the software (an article in and of itself, for another time) 
and eventually uninstalling can be a big task. Even uninstalling one 
release year of those products, when done manually, could mean 
running through 30 or more uninstallation wizards.

This article will guide you through making this process much 
easier and faster, and with less work. Whether you are uninstalling 
just one Autodesk application, all applications of a release year, 
or every Autodesk application, this guide will help you through  
the process. 

TyPICAL WInDoWS UnInSTALL 
The simplest way to uninstall, and the way you’ve likely uninstalled 
programs in the past, is by using the default Windows Uninstaller. 
This is a quick, simple way to remove a handful of programs, 
but requires you to pick each application one by one, running 
through each applications uninstaller steps. This can be a tedious 
process if you are trying to remove many different software  
titles and versions. 

You can access the Windows Uninstaller by going to Control 
Panel -> Programs and Features (see Figure 1). If your control 
panel items are set to “View By: Category” you will find “Uninstall 
a Program” under the Programs section. Both ways get you to the 
same place. From the list of applications, find the application you 
want to uninstall, right-click on it, and select Uninstall. Follow the 
applications uninstallation steps and wait for it to complete. You 
cannot uninstall more than one application at a time, so you may 
have some waiting time between each uninstallation. If you are 
uninstalling more than a couple, this is not an efficient method! 

Uninstalling 
Autodesk 
Software?
Let’s Save you 
Some  
Time!

➲
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AUToDESk UnInSTALL TooL
If you have multiple Autodesk applications to uninstall, 
you can use the Autodesk Uninstall Tool (see Figure 2). 
This is a very handy tool that lists out each Autodesk 
application installed on your system, including utilities, 
enablers, material libraries, etc. 

You simply check the box next to each item you want 
to uninstall and then click Uninstall at the bottom. 
The tool will then begin an unattended uninstallation 
of each application. As it moves through each item, the 
checkbox will change to a flashing red arrow, telling you 
it is working on that item. As it finishes each item, it will 
change to a green check mark, to tell you it is successfully 
uninstalled, or a red X to tell you the uninstall failed. 

I have found that it doesn’t always list every Autodesk app 
and that often several uninstalls will fail. But for a quick 
bulk uninstall that is easy for a user to run, this tool is great. 

WMIC UnInSTALL 
The most versatile way to uninstall is by using the WMI 
command-line Windows Management Instrumentation 
Command (WMIC) utility. This utility can be used 
for a wide variety of tasks, one of which is uninstalling 
applications using the CALL command. This command 
can be customized to uninstall any selection of 
applications by searching based on two types of criteria: 
Vendor and Name. 

Figure 1

Figure 2
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To select Autodesk applications, you can make a call for any 
applications that has the vendor “Autodesk.” Since every Autodesk 
application has that in common, it’s a great way to select all 
Autodesk apps. 

Note that some Autodesk applications list the vendor as “Autodesk” 
and some “Autodesk, Inc.” If you search with ‘Autodesk%’ the 
wildcard ‘%’ will grab both variations of the vendor name. You can 
then use other search terms to narrow down what you want to 
select, like a product year in the application name. 

For example, the Vendor ‘Autodesk%’ and ‘%2018%’ in the product 
name would find all Autodesk applications with 2018 in the name. 
As in the vendor name search, the ‘%’ on either side of the year is a 
wildcard, telling the search to find anything with 2018 in the name, 
regardless of any characters to the left or right of it. 

I will show you the syntax for three of the most common scenarios. 
Uninstalling ALL Autodesk applications, All from a particular 
release year, or from multiple release years. You can modify these 
to fit your specific uninstall needs. 

To get started, you need to first open CMD with elevated 
permissions. (You can also use PowerShell if you prefer.) To open 
CMD, click the Start button and type CMD. You will see the 
command prompt in the list of applications, right-click on it and 
select “Run as Administrator.” If you do not run CMD elevated (Run 
as Administrator), you may get an error when it begins uninstalling. 

In the Command prompt, type “WMIC” and hit enter. This will 
start up the WMIC utility. From here, simply enter the syntax for 
the command you want to run and hit Enter to run it. As is the 
case with any utility, syntax is very important. Be sure you don’t 
miss any spaces, quotations etc. in your command.  I typically 
use the /nointeractive switch, to make each uninstall process  
happen unattended. 

In the list of commands below, don’t include the brackets, { } 
at the beginning and end—they are just here to encapsulate  
the command.  

Uninstall All Autodesk Applications: 
{ product  where “vendor like ‘autodesk%’” call uninstall /
nointeractive }

Uninstall 2017 Autodesk Applications:
{ product where “vendor like ‘autodesk%’ and name like ‘%2017%’” 
call uninstall /nointeractive }

Uninstall 2017 and 2018 Autodesk Applications:
{ product where “(name like ‘%2017%’ or name like ‘%2018%’) and 
(vendor like ‘autodesk%’)” call uninstall /nointeractive }

The WMIC call can be made on your local machine, a remote 
machine, or a list of remote machines.  The above commands will 
run on your local computer. 

To uninstall on a remote computer, prefix the command with { /
node:computername } where ‘computername’ is the hostname of the 

Figure 3
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remote computer. For example: { /node:computername  product 
where “vendor like ‘autodesk%’” call uninstall /nointeractive  } 

To uninstall from a list of remote computers, create a text file 
and save it to your local machine. For this example, I named 
it ‘pc.txt’ saved at C:\removal. The text file will contain the 
hostnames of the computers from which you want to uninstall, 
one hostname per line. No commas or semicolons, just hostnames, 
each on their own line. Prefix the uninstall command with  
{ /failfast:on /node:@”c:\pc.txt” }

For Example: { /failfast:on  /node:@”c:\removal\pc.txt” product 
where “vendor like ‘autodesk%’” call uninstall /nointeractive }

As each application uninstalls, you should get a return value of ‘0.’ 
This means it successfully uninstalled. If you are getting a return 
value of 1603, check to make sure that you ran CMD elevated 
(Run as Administrator).

APPLICATIonS fAIL To UnInSTALL
There are times when an Autodesk application becomes corrupt 
to the point it will not uninstall by any of the above means. 
This typically comes up when an application begins having 
issues running and requires you to reinstall it. However, trying 
to uninstall it fails, and when trying to reinstall, it tells you the 
application is already installed. There are two ways to fix this—by 
using the Microsoft Fix It tool or by manually deleting its folders 
and registry keys.   

Microsoft Fix It Uninstall
The purpose of the Microsoft Fix It utility is to “Fix problems 
that block programs from being installed or removed.” Basically, 
it searches to find the issues that are preventing the uninstall and 
fixing those issues, then removing the application. You can find a link 
to download this tool by searching the AKN (Autodesk Knowledge 
Network, https://knowledge.autodesk.com) for “Uninstall Using 
Microsoft Fix it.” 

Download and Run the utility. On the first screen, click “Next.” 
Then select on the next screen that you are having an issue 
Uninstalling. From the list of applications, select the one you are 
trying to remove and click next. Then, select “Yes, Try Uninstall” 
on the next screen. It will then attempt to repair and uninstall (see 
Figure 4). If it fails to uninstall or the application you want was not 
listed, move on to manual removal. 

Manual Removal
If all other methods of removal have failed, manually removing 
folders and registry keys will be necessary. If you are removing a 
single Autodesk application and leaving others installed, be careful 
to only delete folders and registry keys for that specific application, 
and not shared components. In some extreme cases, if shared 
resources are also corrupt, removing all Autodesk applications 
may be necessary. Before continuing, a quick warning: changes 
made to the Windows registry happen immediately and no backup 
is created automatically. Do not edit the Windows registry unless 
you are confident about doing so.

The first step in a manual removal is 
deleting the Product Code key from 
the registry (see Figure 5). This is what 
tells Windows that the application 
is installed and where to find its 
resources. Open the registry and go to 
HKEY_CLASSES_ROOT\Installer\ 
Products. From the list of Product 
Codes, you need to identify the Product 
Code for the application you are trying 
to remove. Left-click on the first Product 
Code in the list and on the right-hand 
pane of the Registry Editor you will 
see a list of values. Look for the value 
ProductName—this will tell you the 
name of the application for that Product 
Code. You can arrow down through 
each Product Code until you find the 
application you are looking for. You can 
also right-click on the Products key in 
the left-hand pane and select “find” to 
search for the application name.

Don’t forget to also remove Product 
Code keys for sub-applications if they 
would not uninstall as well. For example, 
AutoCAD 2018 also has an “AutoCAD 
2018 Language Pack” that you would Figure 4
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want to remove if you are going to reinstall AutoCAD 2018. Once 
the Product Code keys have been removed, clean up the remaining 
files/folders and registry keys for the application. The next section 
describes that process. 

CLEAnUP AfTER UnInSTALL
Regardless of the way you uninstall, it’s important to do some 
manual cleanup of leftover files and registry keys, especially if 
you are uninstalling and reinstalling because of an issue with the 
application. You can find an Autodesk generic guide for removing 
everything Autodesk, and application-specific guides that will list 
out each folder and registry key that needs to be removed for a 
clean uninstall of that program.

These guides can be found on the AKN (Autodesk Knowledge 
Network https://knowledge.autodesk.com). The simplest way 
to find the guide you are looking for is to use the Search bar on 
the AKN website. Just search ‘Clean Uninstall product year’. For 
example, ‘Clean Uninstall Revit 2018.’ 

Follow the guide, deleting each folder and key it lists. When you 
are done, it’s always a good idea to clear the Windows Temp folder 
before reinstalling. 

For the sake of space here, I won’t list out each folder and key 
for any specific application as they are readily available on  
the AKN.
 

ConCLUSIon 
As you can see, there are several ways to go about uninstalling 
the vast collection of Autodesk software you have installed. This 
article should help you save time and be more successful when 
uninstalling software. 

Bryson Anderson has worked in the IT 
industry since 2008. During this time, 
he has been involved in many aspects of 
IT including Systems Administration, 
Networking, Telecom, Hardware, and 
IT consulting. Bryson has helped large 
and small companies in a variety of in-
dustries including healthcare, software 
development, engineering, and archi-
tecture to plan, implement, upgrade, 
and maintain their IT infrastructure. 
At ProSoft, he administers all aspects 
of the internal IT infrastructure and 
oversees ProSoft’s custom workstation 
and server division. With his knowl-
edge and experience in IT, Bryson con-
sults with companies worldwide on the 
planning, implementation, and train-
ing of Autodesk data management 
and collaboration software as well as 
assisting customers with the licens-
ing, installation, and deployment of  
Autodesk products. 

Figure 5
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AUToDESk SITE DESIGnER ExTEnSIon 
foR REVIT

https://bit.ly/2jsbpaM

Autodesk® Site Designer Extension for Autodesk® 
Revit®  software helps architects, designers, and 
planners convey building site planning concepts to 

engineers. Site Designer runs inside Revit software and uses native 
families, components, and toposurfaces, so site designs become part 
of the overall model.  You can model alternatives for mass grading, 
building pads, streets, sidewalks, parking lots, and retaining walls 
all within the Revit environment.  More easily convert a sketched 
line into a street, sidewalk, curb and gutter, retaining wall, or 
parking lot in the model.   You can manipulate Site Designer 
components using editing tools to change their location, elevation, 
grade, or geometry, and Site Designer automatically updates and 
maintains the underlying toposurface.

Features include:
•	 Report and schedule areas, volumes, and cut and fill volumes 

to better understand the impact of site design changes on 
requirements to move or add fill.

•	 Iterate conceptual designs and create more realistic visuals of 
the building site by incorporating grading features directly 
into the Revit model.   

•	 Share a site model 
between Revit and 
Civil 3D through Land 
XML files, improving 
collaboration between 
architects/engineers 
working on a project.

•	 More quickly add design elements to your site such as 
berms and drainage swales, minimizing the time required 
to mass grade a site and to try alternatives at the design  
development stage.

•	 Locate hardscape components such as streets, intersections, 
sidewalks, curbs, and walls that can follow the existing terrain 
and have controlled elevations and slopes—all while the 
toposurface is automatically maintained.

3D PDf ExPoRTER foR AUToDESk 
AUToCAD - TRIAL

https://www.prototechsolutions.com/

3D PDF Exporter For Autodesk® AutoCAD® 
exports solid and wire bodies to a 3D PDF file.

It has following features:
•	 Support for face level colors.
•	 Set a password on the exported PDF file.
•	 Option to control the file size and quality by specifying 

precision value.
•	 There is always a default compression, which helps reduce the 

file size as much as possible.
•	 Supports Autodesk AutoCAD 2013-2019.

SPIT I-BIM
https://bit.ly/2MbOmhH

SPIT i-BIM Plug-in for Autodesk® Revit® is a smart 
library with more than 230 objects.

The app is fully integrated into Revit through a simple interface. You 
can download a full range of fixing solutions (mechanical, chemical, 
and expansion anchors) into all your Revit projects. The BIM objects 
have been designed to be easily incorporated into an advanced 3D 
building model without reducing its performance or reliability.

Available in version 1.0:
•	 More than 230 objects
•	 Customized browser
•	 Online library update
•	 Direct access to mechanical properties and technical 

datasheets for anchors
•	 Direct link to ETA documentation

Note: This app uses a custom installer (not the standard App 
Store installer).

If you have some news to share with us for future issues, please let 
us know. Likewise, if you are a user of a featured product or news 
item and would like to write a review, we want to know: brian.
andresen@augi.com

Welcome to AUGIWorld Inside Track! Check out the latest opportunities to 
advance your skills, processes, and workflows in your firm with the most current  
AEC-related software and hardware updates available.

by: Brian Andresen
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• Intel® Core™ i7 professionally                
   overclocked to 4.8 GHz
• Up to 2 NVIDIA® Quadro™ RTX GPUs*
• Massive internal storage

* Available in November

The only workstation built to accelerate workflows 
and increase productivity for architects, engineers, 
and BIM managers like you.

(888) 302-0223
512-852-0400

boxx.com/augi

If Revit is your software, 
make this your hardware.
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